CHAPTER ONE

Integration of bioinformatic and chemoproteomic tools for the study of enzyme conservation in closely related bacterial species

Laura J. Keller\textsuperscript{a}, Markus Lakemeyer\textsuperscript{b}, and Matthew Bogyo\textsuperscript{b,c,\ast}

\textsuperscript{a}Department of Chemical & Systems Biology, Stanford University, Stanford, CA, United States
\textsuperscript{b}Department of Pathology, Stanford University, Stanford, CA, United States
\textsuperscript{c}Department of Microbiology and Immunology, Stanford University, Stanford, CA, United States
\textsuperscript{\ast}Corresponding author: e-mail address: mbogyo@stanford.edu

Contents

1. Introduction 2
2. Integration of bioinformatics with ABPP 5
   2.1 Useful bioinformatic tools to integrate with ABPP 5
   2.2 Application of bioinformatic tools and ABPP techniques for profiling \textit{Staphylococcus epidermidis} serine hydrolases 6
3. Protocols 10
   3.1 Intact bacteria labeling with an activity-based probe 10
   3.2 Gel-based ABPP 12
   3.3 Protein-protein BLAST analysis 14
   3.4 Activity profile clustering 16
4. Summary 19

References 19

Abstract

Activity-based protein profiling (ABPP) is a commonly utilized technique to globally characterize the endogenous activity of multiple enzymes within a related family. While it has been used extensively to identify enzymes that are differentially active across various mammalian tissues, recent efforts have expanded this technique to studying bacteria. As ABPP is applied to diverse sets of bacterial strains found in microbial communities, there is also an increasing need for robust tools for assessing the conservation of enzymes across closely related bacterial species and strains. In this chapter, we detail the integration of gel-based ABPP with basic bioinformatic tools to enable the analysis of enzyme activity, distribution, and homology. We use as an example the family of serine hydrolases identified in the skin commensal bacterium \textit{Staphylococcus epidermidis}.
1. Introduction

The rise of resistant and multi-resistant bacterial pathogens poses a serious threat to human health. To overcome the antibiotic resistance crises, discovery of new classes of antibacterial targets is urgently needed. One of the many challenges in this endeavor is that large fractions of many bacterial genomes remain functionally uncharacterized, thus requiring unbiased screening methods to select promising new drug targets that can be chemically modulated. Activity-based protein profiling (ABPP) is a powerful technique that enables rapid and direct identification and quantification of enzyme activities in complex biological samples. An activity-based probe, which is composed of an electrophilic warhead, a linker to confer specificity, and a reporter tag, covalently modifies an enzyme active site in an activity-dependent manner. The combination of the warhead and linker dictates the family of enzymes targeted by the probe. Once target enzymes are labeled, a fluorescent tag allows for visualization of active enzymes via in-gel fluorescence or microscopy, while an affinity tag (e.g. biotin) facilitates enrichment and subsequent mass spectrometry-based identification of the enzymes (Keller, Babin, Lakemeyer, & Bogyo, 2020). Thus, ABPP enables monitoring of the activity of multiple enzymes in parallel in the context of their native cellular environments (Fig. 1A). Specific activity-based probes containing diverse electrophiles such as fluorophosphonates, acyloxyalkyl ketones, vinyl sulfones, and others have been developed to target enzyme families ranging from proteases to glucosidases. For overviews of recent advances in activity-based probes, we refer the reader to comprehensive reviews (Benns, Wincott, Tate, & Child, 2021; Fang et al., 2021; Galmozzi, Dominguez, Cravatt, & Saez, 2014; Keller, Babin, et al., 2020).

One of the most successful classes of ABPs are fluorophosphonates (FP, Fig. 1B), which were designed to target the large and diverse family of mammalian serine hydrolases (Fig. 1C) that includes proteases and lipases, among others (Jessani et al., 2005; Kidd, Liu, & Cravatt, 2001). More recently, FP probes have been applied to characterize serine hydrolases in bacterial pathogens such as *Vibrio cholerae* or *Mycobacterium tuberculosis* (Hatzios et al., 2016; Ortega et al., 2016). In addition to determining which relevant enzyme activities to prioritize for future drug development, ABPP inherently selects for “druggable” enzymes that can be covalently modified. Moreover, it enables characterization of the potency and selectivity of an inhibitor within
a class of closely-related enzymes, as has been demonstrated in *M. tuberculosis* with compounds JCP276, EZ120, and AA692 (Babin et al., 2021; Lehmann et al., 2018; Li et al., 2021).

The human body harbors numerous defined communities of “beneficial” bacteria that comprise, for example, the gut, skin, or vaginal microbiota. The natural flora in these communities aids in immune development, contributes to xenobiotic metabolism, and competes with pathogens for ecological niches. Broad-spectrum antibiotics, which act on pathogen and commensal bacteria alike, can decrease microbial diversity, shift the gut metabolome, and even lead to recurring enteropathogen infections, for example by *Clostridioides difficile* (Avis, Wilson, Khan, Mason, & Powell, 2021; Ramirez et al., 2020). Thus, in the development of antibacterials, there has been a focus on targeting...
pathogen-specific pathways. However, this approach is complicated in the case of pathobionts, which are normal residents of the healthy microbiome but have high pathogenic potential (Chow & Mazmanian, 2010; Jochum & Stecher, 2020; Mazmanian, Round, & Kasper, 2008). These pathobionts are particularly important therapeutic targets, as they are the leading causes of nosocomial infections and often acquire multi-drug resistance, yet they are difficult to selectively target because they have closely related species that are key members of the healthy microbiome (Kamada, Chen, Inohara, & Núñez, 2013; Otto, 2009; Wallace, Fishbein, & Dantas, 2020).

One such pathobiont is *Staphylococcus aureus* (*S. aureus*), which resides symbiotically in the nasal microbiome of 30% of adults but at the same time is a leading cause of bacteremia and infective endocarditis (Tong, Davis, Eichenberger, Holland, & Fowler, 2015). *S. aureus* is closely related to the commensal bacterium *Staphylococcus epidermidis* (*S. epidermidis*), which is frequently isolated from the skin of healthy humans and plays important roles in modulating the immune response during wound healing (Lai et al., 2009; Naik et al., 2012). Using activity-based protein profiling, we identified a serine hydrolase, FphB, in *S. aureus* that functions as a virulence factor and is important for colonization of the heart in a systemic infection mouse model. We identified a chloroisocoumarin-based compound, JCP251 (Fig. 1D), as a potent inhibitor of *S. aureus* FphB (SaFphB) by ABPP. To determine how selective the compound is for *S. aureus*, we performed gel-based ABPP against various other bacterial pathogens and the closely related *S. epidermidis* using a fluorescent derivative of JCP251. This analysis confirmed that while the other pathogen strains did not contain homologs of FphB that could be labeled by the JCP251 probe, we identified a probe-labeled protein in *S. epidermidis* (Lentze et al., 2018). Using a combination of mass spectrometry (MS)- and gel-based ABPP with a broad-spectrum FP probe, protein-protein BLAST, and cluster analysis, we were able to identify the set of serine hydrolases that are conserved between *S. aureus* and *S. epidermidis* as well as amongst clinical isolates of *S. epidermidis*. This allowed us to confirm the identity of the *S. epidermidis* FphB homolog (SeFphB) and its labeling by the SaFphB inhibitor JCP251. Despite the homology between SeFphB and SaFphB, JCP251 did not affect the skin colonization of *S. epidermidis* suggesting a possible alternate function for SeFphB that is not related to colonization (Keller et al., 2020). In this chapter, we will use our efforts in *S. epidermidis* to explain and outline basic bioinformatic tools and how to integrate them with gel-based ABPP to determine enzyme conservation and homology between strains and within closely related species of bacteria.
2. Integration of bioinformatics with ABPP

ABPP is a powerful tool to identify enzymes that are active in a disease-relevant state while also enabling screening for potent and selective inhibitors. ABPP has been successfully applied to pathogenic bacteria such as *Vibrio cholerae* and *Mycobacterium tuberculosis* (Babin et al., 2021; Hatzios et al., 2016; Lehmann et al., 2018; Li et al., 2021). Finding antibacterial targets that are selective for pathogens over beneficial commensal bacteria is relatively easy because close species relatives are not commonly found in the healthy flora of the human microbiota. On the other hand, pathobiont bacteria such as the Gram-positive species *Staphylococcus aureus*, *Clostridioides difficile*, and *Enterococcus faecalis* exist in the human body in complex communities with closely related beneficial bacteria (Kamada et al., 2013; Wallace et al., 2020). Combining bioinformatic approaches with ABPP can be an effective approach to identify promising drug targets in pathobiont species that are not conserved in closely related commensal bacterial species.

Genomic approaches, such as marker gene or whole genome sequencing, are state-of-the-art approaches for the classification of clinical isolates of a single bacterial species (Conlan et al., 2012; Méric et al., 2018; Miragaia, Thomas, Couto, Enright, & de Lencastre, 2007). The combination of gel-based ABPP and quantitative image analysis represents a straightforward and fast alternative to genomic-only techniques. Moreover, focusing on the dynamic regulation of the catalytic activity of an enzyme family, such as serine hydrolases, enables the generation of functional clusters that might better reflect biological conservation across bacterial strains compared to simple sequence homology.

2.1 Useful bioinformatic tools to integrate with ABPP

The most common method of identifying a protein homolog is assessing sequence similarity with the protein-protein Basic Local Alignment Search Tool (BLASTp), which rapidly compares a query protein sequence to a search set of sequences by measuring local similarity (Altschul, Gish, Miller, Myers, & Lipman, 1990). The set of sequences to search against can be composed of a single sequence, a set of sequences, the proteome of a single species, or even entire databases such as all non-redundant GenBank sequences. The BLASTp search returns the protein sequences most similar to the query sequence, their pair-wise alignments with the query sequence, and several metrics for each alignment. These include
the percent identity, which is the fraction of the aligned sequences that have the same amino acid in the same position, and the e-value, which is a statistical measure of the likelihood that another protein sequence in the search set would have a better similarity score by random chance. There is no standard threshold for what percent identity and e-value constitutes a homolog, but combining these metrics with searching the alignment for conservation of residues that are known to be important for protein function, such as active-site residues, can increase confidence in identifying a homolog. Additionally, if the two proteins are reciprocal best hits, meaning that each protein is the top result in a BLASTp search of the opposite proteome, this further confirms that two proteins are likely homologs (Ward & Moreno-Hagelsieb, 2014). All of these approaches can be applied to compare protein identifications in MS-based ABPP experiments across closely related bacterial species and are the starting point for more complex bioinformatic-based analyses.

On the other hand, gel-based ABPP (i.e. labeling samples of interest with fluorescent probes, separating the proteins on an SDS-PAGE gel, and measuring in-gel fluorescence) is an application of ABPP that does not as naturally lend itself to bioinformatic supplementation. However, with image quantification software such as ImageJ, the fluorescence intensity of individual protein bands on a gel can be measured and compared across conditions, allowing relative quantification of the activity of each labeled species. This method is commonly used in competitive gel-based ABPP, where a library of inhibitors is screened by pretreating the sample of interest (i.e. intact bacterial cells) with a compound followed by labelling with a fluorescent probe. The ability of the inhibitor to compete away the probe labeling of a given enzyme can be then quantified, allowing determination of IC\textsubscript{50} values (Chen, Keller, Cordasco, Bogyo, & Lentz, 2019). Alternatively, the fluorescent intensities can be measured along an entire lane, thus generating a profile of enzymatic activity. This enables comparison of global enzyme activities for a given family across different conditions or within related strains. It also provides information on how each enzyme may be differentially regulated. These activity profiles can be visualized as a heatmap and clustered hierarchically with existing packages in R or Python. This allows any experimental sample (i.e. clinical isolates) to be rapidly stratified and compared to other strains in a functional manner.

2.2 Application of bioinformatic tools and ABPP techniques for profiling Staphylococcus epidermidis serine hydrolases

Using a fluorophosphonate activity-based probe, we have previously identified a serine hydrolase in the pathobiont *Staphylococcus aureus*, SaFphB, that
is important in a systemic infection mouse model. The protein is selectively targeted in *S. aureus* by the covalent inhibitor JCP251. However, this study also demonstrated that JCP251 labels an enzyme of similar molecular weight in the closely related skin commensal *S. epidermidis* (Lentz et al., 2018). We thus aimed to determine whether this enzyme was a homolog of SaFphB and how conserved the 11 additional fluorophosphonate–binding hydrolases (Fphs) identified in *S. aureus* are among different species of the *Staphylococcus* genus (Keller, Lentz, et al., 2020). By performing BLASTp searches on custom search sets of the reference proteome for each major staphylococcal strain, we were able to determine that most of the 12 *S. aureus* Fph enzymes were conserved in at least 60% of the almost 50 staphylococcal species tested (Fig. 2A). In particular, homologs of SaFphB were predicted in approximately two-thirds of the species (Fig. 2B). Interestingly, all but two of the Fphs from *S. aureus* have at least one putative homolog in *S. epidermidis*, and three have two homologs, suggesting that there may have been either multiple gene duplication or horizontal gene transfer events.

Fphs are a subset of the serine hydrolase enzyme superfamily, which use a catalytic serine residue to hydrolyze amide, ester, and thioester bonds in metabolites that are important for cell–cell signaling and metabolism (Simon & Cravatt, 2010). Because serine hydrolases are defined by their catalytic mechanism, ABPP techniques with a probe containing a broad serine-reactive warhead such as the fluorophosphonate is an effective method to identify novel serine hydrolases. Importantly, identification of probe-labeled enzymes helps to confirm bioinformatically-predicted annotations. Thus, we also followed up our BLASTp-based Fph homolog predictions with MS-based ABPP of 17 strains of *S. epidermidis*, including reference strains and clinical isolates. In total, we identified 18 serine hydrolases, most of which were the BLASTp-predicted *S. aureus* Fph homologs. Interestingly, four serine hydrolases had not been identified in the profiling of *S. aureus* and one did not have a clear homolog in *S. aureus*, demonstrating how combining bioinformatics and ABPP across multiple related species can enhance the identification of novel enzymes and uncover their conservation within related families of bacteria. In particular, the homolog of SaFphB in *S. epidermidis*, SeFphB, was predicted with BLASTp, was measured by MS-based ABPP, and its similar catalytic function was confirmed by active site conservation and substrate specificity.

To compare the relative activities of the Fphs across the various *S. epidermidis* strains, we performed gel-based ABPP with a fluorescent fluorophosphonate probe (Fig. 3A). We identified substantial variabilities in the activity levels of multiple Fphs in these 17 *S. epidermidis* strains, which
Fig. 2  Conservation of Fph enzymes throughout the genus *Staphylococcus*. (A) Phylogenetic tree of 47 staphylococcal species, with the skin bacterium *Cutibacterium acnes* as the outgroup, by 16S rRNA sequences. Each filled grey cell in the heatmap indicates that species has a homolog of the *S. aureus* Fph, as determined by a threshold e-value of $1 \times 10^{-40}$. *Staphylococcus aureus* and its Fph enzymes, which were the query sequences for each BLASTp search, are highlighted in maroon. (B) Percentage of the 47 staphylococcal species that contain a homolog of the indicated *S. aureus* hydrolase by BLASTp search. Part B: Adapted from Keller, L. J., Lentz, C. S., Chen, Y. E., Metivier, R. J., Weerapana, E., & Fischbach, M. A. (2020). Characterization of serine hydrolases across clinical isolates of commensal skin bacteria *Staphylococcus epidermidis* using activity-based protein profiling. ACS Infectious Diseases, 6(5), 930–938. doi: 10.1021/acsinfecdis.0c00095.
may be due to the fact that these strains are isolated from different microenvironments in the human body (i.e. the nares of a healthy volunteer versus the bloodstream of an infected patient). There have been efforts to categorize *S. epidermidis* clinical isolates into clonal lineages via marker gene and genomic-based techniques, as well as attempts to correlate this clustering with functional assays (Conlan et al., 2012; Espadinha et al., 2019; Méric et al., 2018; Miragaia et al., 2007). Previous work from the Bertozzi group utilized an in-gel assay with a sulfatase-activatable fluorophore to distinguish different mycobacterial species based on their activity “fingerprint” (Beatty et al., 2013). We thus wanted to determine if the Fph activity “fingerprint” or
profile could be used to stratify these 17 *S. epidermidis* strains. Clustering the strains based on their Fph activity profile maintained the close relationship between several pairs of strains, such as SK135 and BCM-HMP0060, but did not preserve the global genomic-based dendrogram nor distinguish the clonal lineages (Fig. 3B). These results were not surprising considering almost all the strains have the same Fph enzymes encoded in their genomes; however, they do suggest that there are interesting strain-specific regulatory pathways of these enzymes that should be further explored.

### 3. Protocols

There are many useful protocols for the design of activity-based probes and their implementation in various ABPP techniques (Galmozzi et al., 2014; Prothiwa & Böttcher, 2020; Sharifzadeh et al., 2020; Steiger, Fansler, Whidbey, Miller, & Wright, 2020). This section will detail general ABPP sample preparation, gel-based analysis to visualize differences in enzyme activity, and basic bioinformatic tools that can be integrated with ABPP.

#### 3.1 Intact bacteria labeling with an activity-based probe

**3.1.1 Materials**
- Bacterial cultures
- Phosphate-buffered saline (PBS)
- Fluorophosphonate-tetramethylrhodamine (FP-TMR) activity-based probe at a concentration of 100 μM in DMSO
- 10% sodium-dodecyl sulfate (SDS) in water
- Non-sterile 1.5 mL Eppendorf tubes or equivalent
- 0.5 mL screw cap microcentrifuge tubes with O-ring (Thermo Fisher #02-707-350) or equivalent
- 0.1 mm glass beads (BioSpec #11079101) or equivalent
- Spectrophotometer
- Bench top incubator
- Bench top microcentrifuge
- Mini-beadbeater-96 (BioSpec) or equivalent
- Aluminum vial rack (BioSpec #702ALU) or equivalent

**3.1.2 Procedure**
1. Prechill aluminum vial rack by storing at -20°C.
2. Measure the optical density of the bacterial cultures at 600 nm (OD$_{600}$) using the spectrophotometer.
3. Centrifuge the bacterial cultures on the bench top microcentrifuge at 3,000 x g for 5 min, remove the culture medium, and resuspend the cell pellets in a volume of PBS such that the final OD$_{600}$ is 16.

4. Add 2 μL FP-TMR probe (100 μM stock) to each 200 μL bacterial culture (1 μM final concentration) and incubate at 37°C for 30 min.

5. Centrifuge the bacterial cultures on the bench top microcentrifuge at 3,000 x g for 5 min, remove the supernatant, and resuspend the labeled cell pellets in the same volume of PBS.

6. Add 10% SDS at a 1:100 dilution (0.1% final concentration).

7. Transfer the samples to 0.5 mL O-ringed tubes filled halfway with 0.1 mm glass beads.

8. Put samples in prechilled aluminum vial rack and lyse by bead-beating, three times for 45 s with 2 min breaks on ice in between each burst.

9. Centrifuge the bacterial lysate at 8,000 x g for 10 min to pellet insoluble cell debris and beads. Transfer the lysate to a new 1.5 mL tube.

10. Quantify protein concentration using the Pierce BCA Protein Assay Kit (Thermo Fisher), following manufacturer’s protocol.

### 3.1.3 Notes

This protocol is written specifically for labeling with a fluorescent FP probe to label serine hydrolases, but the concentrations and incubation times should be optimized for each probe. This can be achieved by first labeling with a range of probe concentrations for a set time and then selecting optimal probe concentrations and performing labeling for varying time periods. Furthermore, for each bacterial species, we recommend optimizing with several different lysis conditions prior to undergoing any full-scale experiment. In our experience, lysis by probe sonication (i.e. three 20-s bursts with the Sonic Dismembrator Model 100 (Fisher Scientific)) is preferred with smaller volume samples; however, lysis by bead-beating is often necessary with Gram-positive bacterial species. Furthermore, various detergent additives and concentrations should be screened to optimize solubilization of membrane-associated proteins.

To identify enzymes that are more likely to be accessible to small molecule inhibitors and thus potential drug targets, we label intact bacterial samples, which, depending on the cell permeability of the activity-based probe used, may bias the labeling toward enzymes that are membrane-associated or found on the external surface of the bacteria cells. Bacterial cells can also be lysed prior to labeling if intracellular targets are of interest—in
In this case, normalize the protein amount by BCA quantification prior to labeling with the activity-based probe.

If the activity-based probe contains an alkyne handle instead of the fluorescent tag, after sample labeling, it can be derivatized with copper-catalyzed azide alkyne cycloaddition (CuAAC) to append a fluorophore (Rostovtsev, Green, Fokin, & Sharpless, 2002; Steiger et al., 2020).

Similar labeling methods can be performed with biotinylated probes to perform mass spectrometry-based identification of the active enzymes. Because methods vary based on instrumentation, a detailed protocol is not provided in this chapter. The general workflow involves (1) labeling the bacteria with a biotinylated activity-based probe, (2) lysing the bacteria, (3) removing excess probe, (4) enriching for labeled enzymes on streptavidin resin, (5) on-bead reducing, alkylating, and digesting the enriched proteins, (6) eluting from the resin, (7) desalting, and (8) MS-measurement. For more detailed descriptions, we refer the reader to previous methods sections from the following papers (Chen et al., 2017; Galmozzi et al., 2014; Kuljanin et al., 2021).

### 3.2 Gel-based ABPP

#### 3.2.1 Materials

- Fluorescent probe-labeled bacterial samples (from Section 3.1)
- PBS
- 4x Laemmli Sample Buffer (1 mL 1.0 M Tris pH 6.8, 400 mg sodium dodecyl-sulfate, 2 mL glycerol, 1 mL β-mercaptoethanol, 10 mg bromophenol blue, dH₂O to a final volume of 5 mL)
- Precision Plus Protein All Blue Prestained Protein Standards (Bio Rad #1610373) or equivalent
- Isopropanol
- 12% acrylamide Resolving Gel (2.4 mL ProtoGel (300% (w/v) acrylamide/bisacrylamide solution (National Diagnostics #EC-890)), 2 mL dH₂O, 1.5 mL 1.5 M Tris pH 8.8, 60 μL 10% SDS in dH₂O, 60 μL 10% ammonium persulfate (APS) in dH₂O, 6 μL TEMED)
- Stacking Gel (750 μL ProtoGel, 2.25 mL dH₂O, 1.75 mL 1 M Tris pH 6.8, 50 μL 10% SDS in dH₂O, 50 μL 10% ammonium persulfate (APS) in dH₂O, 5 μL TEMED)
- 10x Tris-glycine Running Buffer (30 g Tris base, 144 g glycine, 10 g SDS, dH₂O to a final volume of 1 L)
- Standard Dry Block Heater (VWR) or equivalent
- Mini PROTEAN Tetra Cell system (Bio Rad #1658003) or equivalent
• Mini Cell Buffer Dam (Bio Rad #1653130) or equivalent
• Power supply (Thermo Fisher #EC105) or equivalent
• Typhoon FLA 9500 gel scanner (GE) or equivalent

3.2.2 Procedure
1. Dilute each fluorescent probe-labeled sample to 25 μg total protein in 15 μL using PBS.
2. Add 5 μL 4x Laemmli Sample Buffer to each sample, pipet to mix, and boil in a preheated Block Heater for 10 min at 95°C.
3. Assemble the short and 1.0 mm spacer plate in the casting frame, ensuring the short plate is facing out and that the bottoms of the plates are flush with the bench, and transfer the assembly to the casting stand.
4. Combine the reagents for the 12% acrylamide Resolving Gel and pipet between the glass plates to roughly 75% of the height of the short plate, checking for leaks.
5. Add a thin layer of isopropanol on top of the Resolving Gel layer to ensure there are no bubbles and the top of the gel is even, and allow to polymerize for at least 15 min.
6. Pour off isopropanol into a receptacle for organic waste and rinse with dH₂O before proceeding.
7. Combine the reagents for the Stacking Gel and pipet between the glass plates to the top. Carefully place the 15-well comb in between the glass plates without introducing bubbles and allow the Stacking Gel to polymerize for at least 15 min.
8. Dilute 100 mL 10x Tris-glycine Running Buffer in 900 mL dH₂O and add 400 mL of 1x Running Buffer to the Mini-PROTEAN Tetra Cell Buffer Tank.
9. Remove the comb from the acrylamide gel.
10. Sandwich the acrylamide gel with the spacer plate facing out and the Mini Cell Buffer Dam in the Mini-PROTEAN Tetra Electrode Assembly, ensuring the seal with the rubber gasket. If running two gels simultaneously, the Buffer Dam can be swapped for a second acrylamide gel.
11. Fill the sandwiched assembly with 1x Running Buffer, rinse the wells with 1x Running Buffer, and place in the Buffer Tank.
12. Load 20 μL of labeled sample into each well in the desired order. Add 3 μL of Precision Plus Protein All Blue Prestained Protein Standards to either the first or last lane. When loading each well, pipet slowly and
smoothly, ensuring the sample collects at the bottom of the well and there are no bubbles to disrupt the sample.

13. Put the Lid on the Buffer Tank, attach the leads to the Power Supply, and set the voltage at approximately 85 V. Once the sample has passed through the Stacking Gel and entered the Resolving Gel (as monitored by the blue “front” of the samples), the voltage can be increased up to 120 V if desired.

14. Once the blue “front” has run off the bottom of the gel, remove the gel from the sandwiched assembly, rinse with water, and gently dry off.

15. Image the gel using the Typhoon gel scanner at the appropriate wavelength (for the TMR fluorophore, excitation/emission 544 nm/570 nm) for the fluorescent dye in the activity-based probe to generate an in-gel fluorescence image. The photomultiplier tube (PMT) voltage and resolution can be adjusted to increase image quality.

3.2.3 Notes
When casting the acrylamide gel, add the acrylamide just prior to casting the gel as polymerization will begin right away. Avoid any spills as acrylamide in solution is toxic. The percent acrylamide in the resolving gel can be tuned depending on the molecular weight of the protein of interest, with lower percentages such as 10% being better for resolving higher molecular weight proteins and higher percentages such as 15% being better for resolving lower molecular weight proteins (the volume of water is thus increased or decreased accordingly to maintain the same final volume). Additionally, proteins that are difficult to resolve can be better separated by running the gel at lower voltages, i.e. 65 V. The recipes above make one gel but can be scaled up to cast multiple gels. Acrylamide gels can be stored inside the glass plates for up to a week at 4 °C, wrapped in a damp paper towel and cling wrap, prior to use.

3.3 Protein-protein BLAST analysis
3.3.1 Workflow

2. Enter query sequence(s) of interest. The sequences can be formatted as a list of GenBank accession numbers or as FASTA sequences, or an entire .FASTA file can be uploaded. If entering multiple queries, each accession number or sequence must be on a new line. The single letter amino acid code must be used for BLASTp.
3. Choose a search space. The default is the non-redundant protein sequence (nr) database, which contains all GenBank protein translations. This space can be narrowed at various taxonomic levels to all proteins associated with a single phylum, genus, species, or strain (Firmicutes, Staphylococcus, Staphylococcus epidermidis, Staphylococcus epidermidis ATCC 14990, respectively, for example).

4. Select the blastp algorithm and press BLAST.

5. The results include a list of sequences with significant alignments with a hyperlink to its entry in GenBank, metrics like e-value and percent identity, and a visualization of the alignment, including which residues are conserved.

3.3.2 Notes

While the standard algorithm parameters on the web-based BLASTp tool are often sufficient, they can be fine-tuned if needed, i.e. the e-value threshold or the matrix used to calculate the score for a given alignment. The web-based tool can be utilized for many BLASTp searches, but BLAST+ applications can also be downloaded locally onto a server and searches can be performed using command-line tools. Local BLAST+ searches are especially useful for high-volume searches or developing custom target search sets to search against, such as proteomes from the Human Microbiome Project (Consortium et al., 2012). For more detailed instructions, visit the BLAST Command Line Applications User Manual (https://www.ncbi.nlm.nih.gov/books/NBK279690/).

In brief, proteins of interest to be searched against (e.g., an entire proteome) can be downloaded into a .FASTA file from NCBI or other similar databases to create a search set. After installing the standalone BLAST+ programs, the makeblastdb function converts the search set .FASTA file into a BLAST database with the Unix command “makeblastdb -in searchDB fasta -out blastDB -dbtype prot -parse_seqids.” Then, the query sequence(s), also saved in a .FASTA file, can be used in a BLASTp search and the results saved to an output file with the Unix command “blastp -query query.fasta -db blastDB -outfmt 6 > output.txt.” The output file will be saved in a tabular form containing the query sequence ID, the search sequence ID, percent identity, alignment length, number of mismatches, number of gap openings, residue number for the start of the alignment in the query sequence, residue number for the end of the alignment in the query sequence, residue number for the start of the alignment in the search sequence, residue number for the end of the alignment in the search sequence, e-value, and bitscore, which is
another measurement of the confidence of the alignment but independent of the size of the search set. Additional modifications of the BLASTp search can include setting a maximum number of resulting sequences for each query sequence (for one sequence per query, “-max_target_seqs 1”) or a threshold of the minimal e-value (for an e-value threshold of 1e-40, “-evalue 1e-40”).

3.4 Activity profile clustering

3.4.1 Workflow

1. Download an ImageJ image processing package from https://imagej.net/software/ and install (Schneider, Rasband, & Eliceiri, 2012). There are many iterations of the original software, ImageJ, most of which are sufficient for standard image analyses. For the purposes of this chapter, exact details will be based on the Fiji package (Schindelin et al., 2012).

2. Open the in-gel fluorescence image (e.g. in the .tiff or .gel format) from gel-based ABPP in Fiji. Ensure that the gel is perfectly horizontally aligned for the cleanest analysis. The image can be rotated using the Image > Transform > Rotate function.

3. If the image has dark bands on a light background, invert using the Edit > Invert function (Fig. 4, Step i).

4. Using the Straight Line tool, draw a vertical line through a lane (Fig. 4, Step ii).

5. Using the Analyze > Plot Profile function, calculate the fluorescent intensity along the vertical line (Fig. 4, Step iii) and save the data with the Data > Copy All Data function (Fig. 4, Step iv). The copied data can be pasted into an Excel file or similar.

6. Move the vertical line to another lane by using the arrow keys, preserving the y-value of the top point of the line and the length of the line, and measure the fluorescent profile along that line. Continue for every lane of interest. Additionally, measure the fluorescent profile along a region outside of the lanes to serve as a background profile. The resulting Excel file should contain the “Gray Value,” or intensity, at each pixel for every lane, including the background, and be saved as a .CSV file.

7. To smooth the effects of any blemish in the image, the fluorescence profile can be divided into roughly 100 bins by summing across the fluorescent intensities in each bin. As highlighted in the sample code (see Fig. 5, ##BIN), every 15 intensity values of the activity profile
Fig. 4  Quantification of activity profiles from gel-based ABPP using the ImageJ software, Fiji. Step i, *Invert*, if the image has dark bands on a light background; Step ii, draw a *Straight Line* vertically through a lane; Step iii, *Plot Profile* along the vertical line; Step iv, *Copy All Data* to paste in Excel and save the intensity values for the profile.
were summed for each lane in the gel; however, the exact number and size of each bin should be tailored for each gel.

8. Subtract the binned background fluorescent profile from every other profile (see Fig. 5, ##SUBTRACT BACKGROUND AND THRESHOLD).

9. As minor changes in the gel background do not provide valuable information for the purposes of clustering, any values below a background threshold are reassigned a value of 0 (see Fig. 5, ##SUBTRACT BACKGROUND AND THRESHOLD). The appropriate background threshold to use will vary from gel to gel, but should correspond to the background subtracted binned value from a portion of the gel that has no visual bands.

10. Visualize the binned and thresholded quantification of the image utilizing the heatmap package in R, with the rows being each bin along the gel and the columns being each condition in the gel. Use hierarchical clustering within the heatmap package on the columns and show the corresponding dendrogram (see Fig. 5, ## PLOT).

### 3.4.2 Notes

The data processing can be performed manually in Excel, but use of computational platforms such as RStudio (https://www.rstudio.com/products/rstudio/download/) allow more easy manipulation and modification of parameters including bin size and background threshold. In either case, the heatmap and dendrogram generation should be performed with R, Python, or a similar bioinformatically-inclined coding language. If the data...
processing is performed computationally, the conversion of the in-gel fluorescence image to a heatmap can be optimized for each gel by altering the size/number of bins and the background threshold by monitoring the changes in the outputted heatmap, ensuring that each distinct band visualized in the gel is represented in the heatmap. Included is some sample code in R for the data processing and visualizing that should be edited and embellished as needed (Fig. 5).

4. Summary

Activity-based protein profiling is a powerful approach for identifying relevant and druggable bacterial targets. In the context of studying pat-hobiont bacteria that exist with closely related species in the healthy microbiome, this technique can be supplemented with bioinformatic tools such as BLASTp, which can assess enzyme conservation across species, to understand which commensal bacteria might be impacted by targeting a given enzyme. Furthermore, quantification of activity profiles generated with gel-based ABPP and image analysis software enables comparison and stratification of strains of a single bacterial species, thus enabling rapid and functional clustering of clinical isolates. In this chapter, we have detailed the protocols necessary to perform BLASTp searching, gel-based ABPP, image analysis, and clustering to identify related enzymes and functional conservation across related bacterial species. As our reference example, we have used our data generated by the characterization of serine hydrolase conservation in the skin commensal bacterium *Staphylococcus epidermidis*. We are confident that this integration of approaches has great potential to be applied to study additional classes of enzymes and their activity profiles in a wide variety of clinically relevant bacteria.

References


